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http://www.ks.uiuc.edu/Research/vmd/gallery/

Scientific Visualization Tools

Atomsviewer: Billion-atom visualizer
http://cpc.cs.qub.ac.uk/summaries/ADUM v1 0.html

VMD: Molecular-dynamics data
http://www.ks.uiuc.edu/Research/vmd

OVITO: Open visualization tool
https://ovito.org

VisIT: General visualization system
https://visit.linl.gov

ParaView: General visualization system
http://www.paraview.orq
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|| About || Download || Help || Testing


http://cpc.cs.qub.ac.uk/summaries/ADUM_v1_0.html
http://www.ks.uiuc.edu/Research/vmd
https://ovito.org/
https://visit.llnl.gov/
http://www.paraview.org/
http://www.paraview.org
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In Situ vs. Post-processing
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In situ visualization post-processing

Visual debugging & control

In situ visualization using common visualization software?
See B. Whitlock et al., PGV11



https://aiichironakano.github.io/cs596/Whitlock-InSituViz-PGV11.pdf

VMD Software

e VMD (Visual Molecular Dynamics): Molecular
visualization program developed at the University of
Illinois, Urbana-Champaign.

* Downloadable for various platforms—Linux, Windows,
and Mac.

e Install it on your laptop.

Version 1.9.4 LATEST ALPHA (2021-10-07) Platforms:

Latest pre-release ALPHA test version

e Source Code

e LINUX_64 OpenGL, CUDA, OptiX, OSPRay (Linux (RHEL 6.7 and later) 64-bit Intel/AMD x86_64 SSE, with CUDA 9.x, OptiX, OSPRay)
e MacOS 11.x, ARM64 (64-bit "M1" Macs) (Apple MacOS-X 11 or later)

e MacOS 10.15, x86_64 (64-bit Intel x86_64) (Apple MacOS-X 10.15 or later)

e MacOS X OpenGL (32-bit Intel x86) (Apple MacOS-X (10.10.x to 10.13.x) with hardware OpenGL (native bundle))

¢ Windows 32-bit (32-bit Intel x86) (Windows 10)

¢ Windows 64-bit, CUDA, OptiX, OSPRay (64-bit Intel x86_64) (Windows 10)

Version 1.9.3 (2016-11-30) Platforms:

http://www.ks.uiuc.edu/Research/vmd



http://www.ks.uiuc.edu/Research/vmd

XYZ File Format

 VMD can read various file formats such as XYZ and PDB
(Protein Data Bank).

e XYZ file format:

Repeat the following for as many times as the number of frames
(i.e. time steps) you would like to store

line 1: <number of atoms, N>

line 2: comment line
line 3-N+2: atomic element, atom’s X, y & 2z coordinates
(space delimited; coordinate in angstrom)

Example: a methane molecule

5
methane molecule (in dngstroms)

C 0.000000 0.000000 0.000000
H 0.000000 0.000000 1.089000
H 1.026719 0.000000 -0.363000
H -0.513360 -0.889165 -0.363000
H -0.513360 0.889165 -0.363000



Writing an XYZ File from 1md.c

#define SIGMA 3.4 // Lennard-Jones length scale in angstrom
FILE *fxyz;

int main(int argc, char **argv) () {

fxyz = fopen("lmd.xyz","w");
... // Main MD for loop
fclose(fxyz);

}

void EvalProps() {
fprintf (fxyz,"%d\n",nAtom);
fprintf (fxyz, "Molecular dynamics simulation of argon\n");
for (n=0; n<nAtom; n++)
fprintf (fxyz,"Ar %f %f %f\n",r[n][0]*SIGMA,r[n][1]*SIGMA,r[n][2]*SIGMA);

* Run the program with the following input parameters in 1md. in

333 // # of crystalline unit cells in the x, y & z directions

0.8 // Density in the Lennard-Jones (LJ) unit
1.0 // Temperature in the LJ unit

0.005 // Time discretization unit in the LJ unit
500 // Total # of time steps

10 // Interval between consecutive dumps to the XYZ file



Start VMD

e It will open 3 windows

File Molecule Graphics Display Mouse Extensions Help

ID T A D F Molecule Atoms Frames Vol

Main window

= (1} -
4 ﬂ' zoom [ |Loop vl step 1| 1 :| speed] i I}
£ aiichironakano startup.command — vmd_MACOSXX86 66x25
. . Last login: Tue Oct 21 14:44:37 on console L
Dlsplay Wlndow Aiichiros-MacBook-Pro:~ aiichironakano$ /Applications/VMD\ 1.8.6.a

pp/Contents/Mac0S/startup.command ; exit;

Info) WD for MACOSXX86, version 1.8.6 (April 6, 2007)

Info) http://www.ks.uiuc.edu/Research/vmd/

Info) Email questions and bug reports to vmd@ks.uiuc.edu

Info) Please include this reference in published work using VMD:

Info) Humphrey, W., Dalke, A. and Schulten, K., "VMD - Visual

Info) Molecular Dynamics', J. Molec. Graphics 1996, 14.1, 33-38

info)

Info) Multithreading available, 8 CPUs detected.

Info) OpenGL renderer: NVIDIA GeForce GT 7560M OpenGL Engine

Info) Features: STENCIL MDE CVA MTX NPOT PP PS GLSL(OVF)

Info) Full GLSL rendering mode is available.

Info) Textures: 2-D (16384x16384), 3-D (2048x2048x2048), Multite
xture (8) -

vmd > || .
- Command terminal



Load the MD-Trajectory XYZ File

e In the File menu in the VMD main window, select New Molecule;
the following new window will open.

Load files for: INew Molecule Bt

Determine file type:
|Aut0m atically

-

~ Volumetric Datasets

Frames:
First:

Stride: |

ad in background
7Load all at once

 Drag and drop the XYZ file you have crgated in the Filename field
(or press the browse button to locate the file).

* Click the Load button to load the file.



Choose the Graphic Representation

e In the Graphics menu in the VMD
main window, select Representations; Selected Molecule
the following new window will open. e E

\ Create Rep Delete Rep I
Style Color Selection

VDW Name all

Selected Atoms

|a||

Draw style | Selections | Trajectory | Periodic |
Coloring Method Material
[Name | |Opaque ]|

Drawing Method
[vow -] Default |

Sphere Scale #|{[ 1.0 }|®

Display now looks like this

Sphere Resolution §({[ 8 }|#

* In the Drawing Method menu, choose o APy Changes ),
. Automatically ———1
the VDW (van der Waals radius)
representation.




Animation

e (Click the play button in the VMD main window to play the movie.

Atoms Frameg




Optional: Creating a Movie File (1)

e Choose the Extensions — Visualization — Movie Maker menu; this will open
a VMBMovie Generator window.

- | ovie Lenerator
8 00 VMDD Movie G t
enderer % ovie Settinas + || Forma = elp
——— Rend 4 || Movie Setti = |.F t | | Hel =
ain -
; ; m /s/ Rock and Roll (XY lemniscate)
File Molecule Graphics Display Mouse RSAERETE | Set working direﬁ ROt SP oIV A% pp4z00000gn/T/
, Analysis  »| )
Data » Name of movigf: 'lun  Trajectory Rock
Modeing User Defined Procedure
Simulation »
Camera Navigator (Keys) W Rotation ghgle: |18 4. :
. AT - Tk Console | Camera Navigator (Mouse) " - L Image_smOOth"Tg
(4|4l zoom = [Loop ] step 4 1 M speed " Clipping Plane Tool 2: Half-size rescaling
C“’"a;"al"e’e:::“a‘b"s Trajeglory step size:  3: Text labelling
Dipole Moment Watcher v 4: Delete image files
oL , Text label settings...
B 'OV duration (seq
PaletteTool
ﬁ:ﬁfﬂv Status: Ready _
iewer :
Stage: 0 of 0 Rock and Roll (XY lemniscate)

Progress: O of O i

Rotation about Y axis

e Unclick (1) the “Rock and Roll”

& (2) “Delete image files” options, | MakeMovie || Abort | Trajectory Rock

while clicking the “Trajectory” User Defined Procedure
[ ] [ ] “ (] [ ] ,’

option, in the “Movie Settings 1: Image smoothing

menu. 2: Half-size rescaling
3: Text labelling
4: Delete image files
Text label settings...




Optional: Creating a Movie File (2)

e Choose a directory, in which a sequence of image files will be stored, using
the “Set working directory” field.

Renderer * || Movie Settings * || Format | Help - |
AN
Set working directory: | MJsersfaiichironakano/Desktop/ArMovie

Mame of movie: untitled £ ArMovie
Rl m| | Ev| (v (B =
) Back View Arrange Action Dropbox
Rotation angle: 180 ~ : ———
‘ ArMovie =+
FAVORITES Name A
Trajectory step size: | 1 <5 Dropbox untitled.0000.ppm
'E\; All My Files untitled.0001.ppm
. untitled.0002.ppm
— € AirDrop

untitled.0003.ppm
untitled.0004.ppm
untitled.0005.ppm

Maovie duration (seconds): 10 \ I
#\; Applications

Desktop

ol ol ol e e ey ey ey ey ey e

=1 untitled.0006.ppm
Swas; F!eady @ Documents untitled.0007.ppm
Stage: 0 of 0 0 Downloads untitled.0008.ppm
Progress: O of 0 7 Google D... untitled.0009.ppm
untitled.0010.ppm
DEVICES
Make Movie Abort

e Click the “Make Movie” button; you will find image files in the directory.



Optional: Creating a Movie File (3)

[ (]
o)
e Use a software such as QuickTime pen
. <[> )(zz JBl m| m ) = v ] [ @ ArMoviePNG
Player to convert the image sequence |
° fo FAVORITES Name A Date Modified
tO a movie lle- (Z] Dropbox B untitled.0000.png 12:09 PM
, = All My Files E untitled.0001.png 12:09 PM
® QuickTime Player 7 | ii0 Edit View Window Help e Pappiications B untitled.0002.png 12:09 PM
8 B untitled.0003.png 12:09 PM
New Player 3#EN Desktop B untitled.0004.png 12:09 PM
New Movie Recording N @ Documents B untitled.0005.png 12:09 PM
. . AN E untitled.0006.png 12:09 PM
New Audio Recording 3N © Dpownloads B untitled.0007.png 12:09 PM
3 {C] Google Drive B untitled.0008. 12:09 PM
Open File... #0 B E:t:tI:d.OOOQ.E:: 12:09 PM
Open URL... ¥8U DEVICES _ B untitled.0010.png 12:09 PM
Open Image Sequence Remote Disc B untitled.0011.png 12:09 PM
AN-Home-4TB A B untitled.0012.png 12:09 PM
Open Recent B untitled NN12 nna 12:00 PM
SHARED

Close W
Q | Cancel Open

Frame rate: | 10 frames per second % |

* Before this step, we have converted the PPM
(portable pixmap) image files created by
VMD to PNG (portable network graphics)
image files that QuickTime Player can read,
using the GraphicsConverter software.




Dynamic Coloring

e In VMD, USER fields in the TRAJECTORY
data category can be animated as color changes
according to one of the built-in color scales

occupied

Fe2t
A

oxidation \reduction
Occupation: e- e-
E ;:zg Fe3+

0.00

unoccupied

C. M. Nakano, H.S. Byun, H. Ma, T. Wei, & M.Y. EI-Naggar, Comput. Phys. Commun. 193, 1 ('15)


https://aiichironakano.github.io/cs596/Nakano-VizBET-CPC15.pdf

Scripting in VMD

VMD allows Tcl scripting language for user to control visualization

Go to File - New Molecule menus — load complex16 pdb—cytochrome
(MtrF-OmcA) dimer data—in Filename textbox
> Graphics — Representations — choose NewCartoon in Drawing Method

Extensions — Tk Console — type the following commands in console

$cd csci596-as07 Absolute path that contains Tcl script named userb.tcl
¥source userb.tcl

It loads FeOcc.pdb—time series of Fe positions & their occupations (0 or 1)
> Graphics — Representations (make sure Selected Molecule is FeOcc.pdb)

>> Drawing Method — VDW; set sphere scale to be 4.0
>> Coloring Method — Trajectory — User — User
> Graphics — Colors — Color scale - Method: BWR

Click play button in VMD main window for animation



Tcl Script

e In FeOcc.pdb file, “beta” value in the last column is customized to represent
electron occupation (0 or 1) for each Fe atom; Tcl script FeOcc.pdb transfers
it to “user” field used for VMD coloring

https://aiichironakano.qgithub.io/cs596/src/viz/userb.tcl

mol new FeOcc.pdb waitfor all
set all [atomselect top all]
set frame 0

set in [open FeOcc.pdb r]

set beta {}

while { [gets $in line] != -1 } {
switch -- [string range $line 0 3] {
END {

Sall frame Sframe
Sall set user Sbeta
set beta {}
incr frame
}
HETA -
ATOM {
lappend beta [expr [string range $line 60 65]]

}
}
}

Find more examples: https://www.ks.uiuc.edu/Research/vmd/script_library/
Publish your Tcl script as VMD plugin: |. Balabin et al., J. Comput. Chem. 33, 906 ("12)



https://www.ks.uiuc.edu/Research/vmd/script_library/
https://aiichironakano.github.io/cs596/Balabin-ETpathwayViz-JCompChem12.pdf
https://aiichironakano.github.io/cs596/src/viz/userb.tcl

Gaussian Cube File Format

 Cube file format: Describes volumetric data (e.g., electronic
wave function or charge density) as well as atom positions

Ay

<header> : °
<comment> ° °

24 0.000000 0.000000 0.000000 // # atoms & origin

63 0.198958 0.000000 0.000000 // # of voxels 1lst axis

63 -0.099479 0.172302 0.000000 // 2nd B0,
189 0.000000 0.000000 0.194054 // 3rd I\ d e

42 0.000000 -0.000013 3.618358 4.860106 // atomic #, nuclear charge,

42 0.000000 6.267168 3.618358 4.860106 // & atomic position vector

0.29654E-04 0.25769E-04 0.20454E-04 0.15027E-04 0.98477E-05 0.53243E-05
// volumetric data (see the code below)

for (ix=0;ix<NX;ix++) {
for (iy=0;iy<NY;iy++) {
for (iz=0;iz<NZ;iz++) {
printf("%g ",data[ix][iy]1[iz]); if (iz % 6 == 5) printf("\n");
} printf("\n");
}
}



Isosurface Rendering

* Load a cube file https://aiichironakano.github.io/cs596/src/viz/MoSe2-hole.cube

e Draw atoms using VDW representation & bond between atoms using
dynamic—bond representation (adjust sphere radius & bond cutoff)

 Draw the volumetric data using isosurface representation (adjust isovalue)

Selected Molecule

|0: MoSe2-hole.cube ﬂ

Create Rep | Delete Rep

Style Color Se

VDW Name all

\ VDW Name all VDW Name all
DynamicBonds Name all DynamicBonds Name all

Selected Atoms

|a||

Draw style| Selections| Trajectory| Periodic|
Coloring Method Material
[Name ~| [ Opaque ~|

Drawing Method
|VDW vI Default |

Sphere Scale «l {I 0.3 ﬂll

Sphere Resolution «l(l 12 }|»|

¢ Apply Changes Automatically App|y|

Selected Molecule Selected Maolecule
|0: MoSe2-hole.cube :I |0: MoSe2-hole.cube :I
Create Rep Delete Rep | Create Rep | Delete Rep I
Style Color ion Style Color Selection

Isosurface Name <volume>

Selected Atoms Selected Atoms
|a|| [

Draw style| Selections] Trajectory] Periodicl Draw stylel Selections| Trajectory| Periodicl

Coloring Method Material Coloring Method Material
IName vl IOpaque vI [Name ~| | Opaque ~|

Drawing Method Drawing Method
IDynamicBondva Default | Ilsosurface vI Default |
Rangel 0 |85018 VolIvoIO: MoSe2-h VI

Distance Cutoff {I 26 kB

Bond Radiusi{l 01 k@

[ Isovalue|0.001088| i

Step!'il 1 M Draw | Solid Surface ﬂ

Bond Resolution ﬂ|{| 6 )l»l Size «I{l 1 M Show Box+|sosur1‘a0tv|

¢ Apply Changes Automatically Apply| ¢ Apply Changes Automatically Appiyl



https://aiichironakano.github.io/cs596/src/viz/MoSe2-hole.cube

Isosurface Rendering

Mo-Se bond

Hole wave
function




Wave Functions in MoSe, Bilayer

* Highest occupied states (blue) are d,,-like
* Lowest unoccupied states (red) are d,,-like

Try a different
El rendering method:
ectron .
H File —
ole
render —

tachyon internal

M.-F. Lin et al., Nature Commun. 8, 1745 ('17)



Beautity in One Hour?

Before After

Default VMD rendering Enhanced with POV-ray ray tracer
http://www.ks.uiuc.edu/Research/vmd http://www.povray.org

Try: File — render — POV-Ray

M.F. Lin et al., Nature Commun. 8, 1745 ('17)


http://www.ks.uiuc.edu/Research/vmd
http://www.povray.org/

OVITO Software

OVITO (Open Visualization Tool): Scientific visualization
and analysis software for atomistic & particle simulation
data.

A. Stukowski, “Visualization and analysis of atomistic simulation data with OVITO —
the Open Visualization Tool,” Modelling Simul. Mater. Sci. Eng. 18, 015012 (*10)

Downloadable for various platforms—Linux, Windows,
and Mac.

Install it on your laptop.
https://www.ovito.org

OVITO Basic OVITO Pro
Open-source software — limited feature set Professional version — full functionality
Version 3.9.2 — 31 Aug, 2023 Version 3.9.2 — 31 Aug, 2023

Unfortunately, the isosurface feature is no longer free!


https://www.ovito.org/

Isosurface Rendering Using OVITO

e Start OVITO & choose the *“file” then “load file” menu

* (1) Load a cube file https://aiichironakano.github.io/cs596/src/viz/IMoSe2-hole.cube,
(2) specifying “Gaussian Cube Files” format

@& Ovito [File | Ed

OVITO Basic (Open Visualization Tool)

e O El] ; : & s
op 0
< =v = Cube-example c Q
Name Date Modified Si Kind
@ vmdscene.pov 10/22/18 11.7 MB BBE...er
MoSe2-hole 10/21/18 22 KB Text...e
= angle-v6.png 10/21/18 25MB  PNG
4 MoSe2-hole.jpg 10/21/18 131 KB JPEG
4 MoSe2-hole.tga 10/21/18 786 KB TGA...ad

@ Gaussian Cube Files (*) | ¥
New Folder Options Cancel [ Open |



https://aiichironakano.github.io/cs596/src/viz/MoSe2-hole.cube

Isosurface Rendering Using OVITO

e Choose (1) “Add modification” then (2) “Create isosurface” menu

)24 (o] e
/ Add modification... M 1
Analysis s
Atomic strain MoSok ho

Cluster analysis

Coordination analysis

Dislocation analysis (DXA)
Displacement vectors

Elastic strain calculation

Grain segmentation (experimental)
Histogram

Add modification... T}

Vistal elements

Simulation cell
Particles

Voxel grid

Data source
Spatial binning (Pro) L MoSe2-hole.cube [Cube]
Spatial correlation function
Time averaging (Pro)
Voronoi analysis

Wigner-Seitz defect analysis
Coloring

Ambient occlusion
Assign color

Color coding ﬁ
Maodification
Affine transformation
50 S 8L

Combine datasets

Simulation cell

Particle types

Compute property Dagfsource
Delete selected 3

urrent file: MoSe2-hole.cube
Freeze property imple

Load trajectory Directory: Ire/09Viz/Demo/Cube-example
Python script (Pro)
Replicate

Slice

Smooth trajectory
Unwrap trajectories

Wrap at periodic boundaries
Selection

Clear selection

File sequence

Search pattern: MoSe*-hole.cube
auto-generate  Found 1 matching file
Trajectory

Current frame:

Showing frame 1 of 1

Expand selection Playback ratio: 1/1 Change...
Expression selection

Invert selection SIELE

Manual selection 24 atoms

Select type 63 x 63 x 189 voxel grid

Structure identification
Ackland-Jones analysis
Centrosymmetry parameter
Chill+
Common neighbor analysis
Identify diamond structure
Polyhedral template matching

VoroTop analysis
Visualization

WOl Global Attri Construct surface mesh

|
e)
& 0
V &

Create bonds

2 l Create isosurface '
enerate trajectory lines




Isosurface Rendering Using OVITO

* Adjust isolevel to draw a desired isosurface

‘. ) OVITO Basic (Open Visualization Tool)

P .
MoSe2-hole.cube [Cube] d H
Add modification... [T}
Visual elements -
Simulation cell .
Particles
Voxel grid
Isosurface
Modifications
Create isosurface
Data source

MoSe2-hole.cube [Cube]
Simulation cell

Particle types

Operate on: Voxel grid: Voxel grid

=
<]
- -

Field quantity: Property

Perspective Isolevel: 0.0003\ : A

500000
400000

300000

Count

200000

100000

0

o e e e e T i M ma
0 0002 0004 0006 0008 001
Property

Field value range: [0, 0.0085018]

Surface

Surface color:

«»
>

Transparency: 0%
Smooth shading
Flip surface orientation
Highlight edges

QCCEEN  Global Attributes Data Tables Voxel Grids Surfaces

Cap polygons

Screenshot [P
O & > il



Make Journal Covers

Vol.29 « No. 43« November 20 « 2017

Y cc A DVANCED
MATERIALS

8 2% 2% 2% 2% a2
-

e

Showcasing research from Collaboratory for Advanced
Computing and Simulations (CACS), University of Southern
California, Los Angeles, USA.

Semiconductor—metal structural phase transformation in MoTe,
monolayers by electronic excitation

Optical control of transformations between semiconducting
and metallic phases of two-dimensional materials can open the
door for phase patterning of heterostructures for 2D electronics
and catalysis applications. This work shows how optically-
induced changes to the electronic structure and Fermi surface
of monolayer semiconductors couple to lattice distortions,
resulting in a more facile phase transformation pathway. This
work highlights photoexcitation as a viable technique for
functionalizing these material systems.

See Aravind Krishnamoorthy et al.,
Nanoscale, 2018, 10, 2742.

ROYAL SOCIETY .
OF CHEMISTRY rsc.li/nanoscale

Registered charity number: 207890

» '
#WAI LEYAICH
N A

)

# P 0 <

V. Kochat et al., Adv. Mater. 29, 1703754 (’17) A. Krishnamoorthy et al., Nanoscale 10, 2742 ('18)


https://www.blender.org/

Or report cover

BASIC ENERGY SCIENCES

EXASCALE
# REQUIREMENTS
el REVIEW

An Office of Science review sponsored jointly by
Advanced Scientific Computing Research and Basic Energy Sciences

16,661-atom QMD

Shimamura et al.,
Nano Lett.
14, 4090 ('14)

10°-atom RMD

Shekhar et al.,
Phys. Rev. Lett.
111, 184503 ('13)

NOVEMBER 3-5, 2015

X% U.S. DEPARTMENT OF

@ ENERGY

ROCKVILLE, MARYLAND




Touch of Art

May 2021 Volume 61, Issue 5 pubs.acs.org/jcim

JOURNAL OF
CHEMICAL INFORMATION
AND MODELING

ACSPublications wwasers A Nazarova et al., JCIM 61, 2175 ('21)

@ Most Trusted. Most Cited. Most Read.



Where to Go from Here

e Keep refining your visualization skill using the examples in this lecture as a
starting point: “Seeing 1s believing”

e It’s the content that matters: “Summarize your work in 100 milliseconds or
less... the importance of the table of contents image,” J. Buriak, ACS Nano 5,
76877 (°11); https://aiichironakano.qgithub.io/cs596/Buriak-ToC-ACSNano11.pdf

* Appeal to fast thinking by ToC image, convince via slow thinking by
abstract; see “Thinking about thinking” by Daniel Kahneman:

https://www.edge.org/events/the-edge-master-class-2007-a-short-course-in-thinking-about-thinking

Application of First-Principles-Based Artificial Neural Network
Potentials to Multiscale-Shock Dynamics Simulations on Solid
Materials

Masaaki Misawa,* Shogo Fukushima, Akihide Koura, Kohei Shimamura, Fuyuki Shimojo,
Subodh Tiwari, Ken-ichi Nomura, Rajiv K. Kalia, Aiichiro Nakano, and Priya Vashishta

Cite This: J. Phys. Chem. Lett. 2020, 11, 45364541 I: I Read Online

ACCESS | [l Metrics & More ‘ Article Recommendations | @ Supporting Information . . .
Squishing skyrmions:

ABSTRACT: The use of artificial neural network (ANN) potentials trained with( ﬁrst)— 1.5 [ First-principles MD " ' Sym metl'y-g u ided dynam iC

principles calculations has emerged as a promising approach for molecular dynamics (MD :

simulations encompassing large space and time scales while retaining first-principles accuracy. ! » @ AN training tranSfo r_matlon Of pOIar

To date, however, the application of ANN-MD has been limited to near-equilibrium processes. s, to pOIOg ies u nder

Here we combine first-principles-trained ANN-MD with multiscale shock theory (MSST) to combpres si on

successfully describe far-from-equilibrium shock phenomena. Our ANN-MSST-MD approach _, gf—i——t ‘ ——t p

T. Linker et al., J. Phys. Chem.
Lett. 13, 11335 ('22)

describes shock-wave propagation in solids with first-principles accuracy but a 5000 times
shorter computing time. Accordingly, ANN-MD-MSST was able to resolve fine, long-time
elastic deformation at low shock speed, which was impossible with first-principles MD because
of the high computational cost. This work thus lays a foundation of ANN-MD simulation to
study a wide range of far-from-equilibrium processes.

Particle velocity (km/s) Particle velocity (km/s)



https://aiichironakano.github.io/cs596/Buriak-ToC-ACSNano11.pdf
https://www.edge.org/events/the-edge-master-class-2007-a-short-course-in-thinking-about-thinking

Where to Go from Here

There are two

types of people:

1. Those that can extrapolate
from incomplete data.

Assignmen et started!



